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Overview

This document provides a quick overview of how to use Medicare DDE to connect to FISS, including step-by-
step instructions for installing DDE and logging into the system.

Medicare DDE provides rapid and secure access to:
e Direct Data Entry (DDE)
e Fiscal Intermediary Shared System (FISS)
e Common Working File (CWF)

Medicare DDE will transform the way you connect to the Medicare DDE system. Using your desktop, you can
access all your Medicare fiscal intermediaries using a high-speed, HIPAA-compliant connection. You have the
ability also to open multiple fiscal intermediaries at one time.

How does Medicare DDE work?

Direct Data Entry (DDE) lets you enter claims in all Fiscal Intermediary Standard System (FISS) that you have
access to. You can then edit, correct, and run status and beneficiary eligibility inquiries (HIQA and HIQH) on
your claims. You'll be able to work with information directly from the Common Working File (CWF) and Multi-
Carrier System (MCS). Because you have a live connection with Medicare DDE, the changes you make to a
claim take effect immediately.

Installing the Java version of DDE

Medicare DDE is a Java-based application that allows you to use Internet Explorer, Chrome, or Firefox to
initially access the program. After you download and run the program, you will not need to use an internet
browser to access DDE.

1. After you receive confirmation that Waystar completed the DDE setup process on our end, open
Internet Explorer, Chrome, or Firefox and navigate to:

https://DDE.ecorpnet.com
Log in using your eSolutions credentials.
Click the Launch Medicare DDE button.

IVIedica re DDE ‘ Notifications @ Help ;;; Demo Account ¥

Facility
ESI All Payer Testing (2403)

Medicare DDE allows you to take advantage of eSolutions' secure direct connection to Medicare. This connection allows you to
process claims and check eligibility just as you normally would.

Reports
If you need any assistance, please contact Client Services at 1.866.633.4726

Launch Medicare DDE

4. Follow the instructions in the next section, depending on your browser.
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Internet Explorer installation instructions

To install using Internet Explorer:

1. Download the java file. ( % |
2. From the pop-up that will appear, ensure Do you want to run this application?
the Do not show this again... checkbox Name:  BlueZone Web-to-Host
1S SeIeCted' ‘.::_"(.) Publisher: Rocket Software, Inc.
. —
Click the Run button. Location:  http:[f172. 16.39.211:8888
Click the BlueZone icon to access the This application will run with unrestricted access which may put your computer and personal

information at risk. Run this tion enly if you trust the location and above.
program. in & applica y if you publisher Ve

IDomtsl'mwﬁ'isangorappsﬁomﬁ'ﬁprisfﬁmdbGﬁondmvel

a More Information ’ Run ] [ Cancel

A "y

You won'’t need to use the browser again.

Chrome installation instructions

To install using Chrome:

1. Download the java file.

2. At the bottom-left corner of the browser, click the Keep button.

This type of file can harm your computer. '
ys Discard
[ Do you want to keep bzwZh,nlp anyway? - | [

3. At the bottom-left corner of the browser, click the .jnlp file or click the Open selection from the menu.

Show in folder

=l bzwzh.nlp
4. From the pop-up that will appear, ensure <)
f[he Do not show this again... checkbox Do you want to run this application?
is selected.
. Na BlueZone Web-to-Host

Click the Run button. ¢ e uefone Tebto
=2 Publisher: Rocket Software, Inc.
—

Click the BlueZone icon to access the e

program.
This application will run with unrestricted access which may put your computer and personal
information at risk. Run this application only if you trust the location and publisher above,
| [¥] Do not show this again for apps from the publisher and location above |
, . More Informati R Cancel
You won't need to use the browser again. E o e [ J|[ core
. v
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Firefox installation instructions

To install using Firefox:

1.
2.

Download the java file.

From the pop-up window that will appear, click the Do
this automatically for files like this from now on

checkbox.
Click the OK button.

From the next pop-up window that will
appear, ensure the Do not show this
again... checkbox is selected.

Click the Run button.

Click the BlueZone icon to access the
program.

You won'’t need to use the browser again.

© 2022 Waystar Health. All rights reserved.
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Opening bzw2h.jnlp

You have chosen to open:
. bzw2h.jnlp

which is: JNLP File (1.8 KB)
from: http://172.16.39.211:8888

What should Firefox do with this file?

@ Openwith

Java(TM) Web Start Launcher (default) ']

() Save File

I Do this automatically for files like this from now on. I

Settings can be changed using the Applications tab in Firefox's Options.

OK

Cancel

Do you want to run this application?

BlueZone Web-to-Host

Publisher: Rocket Software, Inc.

fﬂi«-"\.\

Location:  http://172.16.39.211:8888

This application will run with unrestricted access which may put your computer and personal
information at risk. Run this application only if you trust the location and publisher above.

| [¥] Do not show this again for apps from the publisher and location above |

Run Cancel

E More Information
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Entering the CMS window

The following window will appear with S1 — eSolutions — Navigator V1 as the title. The window will show CMS
text on the screen if the connection was successful.

1. Type in the number for the data center you use.

l @ 51 - eSolutions - TempDev

File Edit Session Options View Script Help
4 PFO1  PFO2 PFO3 PFO4 PFO5 PFOB PFO7T PFO8 PFOS  PFID  PFI1 Attention  Clear

Connections: | & TempDev ~| G 2 El

2. The following login screen appears. You are now connected to FISS with Medicare DDE. Continue
reading for additional instructions.

i §1 - eSolutions - Navigator 2.0

Fie Edt Session Opbiors  Transfer Wiew Matro Script Help

|Eomwiona: & Verizon Disct v & | 208 BEEES
|P‘FCI] FFZ PFRI3 PFRM PROS PRDE PROT  PFOB  PFO9  PFI0  FFL1 Clear  Attention

REL 5.2/0@

Userid: (or LOGOFF) 16:17:33

e8/15/11
TivZez2ls
3192-2A

SMRTTEST

Password :
New Password:
Account:
Transfer:

Data contained is this system is confidential and proprietary. Use of this data
for other than legitimate purposes authorized by CD5 of S5C will be prosecuted

Ready 156.73.215.10 TIVZ0218 ki 00:00:46 14,020
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Getting started

Complete these steps in the following order:

1. Review the information if Java is restricted on your workstation.

2. Add the website to the Internet Explorer® Trusted Zone.

3. Install an Active X Control.

4. Log into a Medicare DDE session.

If Java is restricted on your workstation

There are a few things you need to set up before installing Medicare DDE and software that works with it.
Please make sure you are aware of the following:

o Medicare DDE uses an Active X control. You need administrative rights to install programs on a
computer or an administrator needs to be logged in.

¢ Internet Explorer 64 bit is the preferred browser. Medicare DDE does not support Mozilla Firefox™,
Apple® Safari®, or Google® Chrome®.

e A static IP address is required to establish connection.

e For security purposes, if working from home, Waystar requires a static IP address or a VPN connection
to your organization’s network, where a static IP has already been configured.

Add the website to the Trusted Zone

Before you begin using Medicare DDE, you’ll need to add the website to the Trusted Zone in Internet
Explorer. If you have administrative rights on your computer, you can do this yourself. If your privileges are
restricted, you may need to have a System Administrator at your site do this for you. You may also need to
have the administrator log in to your computer and allow the Active X control to be installed.

To add the website to the Trusted Zone:
1. Open Internet Explorer.

2. From the Tools menu, select Internet Options.

- O X
& aboutblank P~ & || @ Blank Page T ©

Print >

File >
Zoom (100%5) »
Safety »

Add site to Apps

View downloads Ctrl+)

Manage add-ons
F12 Developer Tools
Go to pinned sites

Compatibility View settings

* Internet options

About Internet Explorer

© 2022 Waystar Health. All rights reserved. waystar.com 7
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3. From the Internet Options window that will appear, click the Security tab.

Internet Options ? x

General Security Privacy Content Connections  Programs — Advanced

Home page
l/) To create home page tabs, type each address on its own line.
-
W

Use current Use default Use new tab

Startup
() Start with tabs from the last session
(®) Start with home page

Tabs
Change how webpages are displayed in tabs. Tabs

4. Select Trusted sites and then click the Sites button.

Internet Options ? >

General Security Privacy Content Connections Programs Advanced

Select a zone to view or change security Setﬁy

Internet  Localintranet QU= Restricted
sites

trust not to damage your computer or
your files,

Security level for this zone
Allowed levels for this zone: All

Medium

- Prompts before downloading potentially unsafe
B content
- Unsigned ActiveX controls will not be downloaded

[CJEnable Protected Mode (requires restarting Internet Explorer)

Custom level. .. Default level

Reset all zones to default level

Cancel Aply

Trusted sites Site ‘
J This zone contains websites that you ==

© 2022 Waystar Health. All rights reserved.
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5. Inthe Add this website to the zone field, type or copy https://[DDE.ecorpnet.com
6. To the right of the field, click the Add button.

7. At the bottom of the window, click the Close button.

Trusted sites X

You can add and remove websites from this zone. All websites in
¢ this zone will use the zone's security settings.

Add this website to the zone:

#| https://navigator.ecorpnet.com/ | | Add

Websites:

Remove

Require server verification (https:) for all sites in this zone

Clase F

The Medicare DDE website is now added to the Internet Explorer Trusted Zone.

© 2022 Waystar Health. All rights reserved. waystar.com 9
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Install an Active X control

ActiveX controls are small, add-on programs that are used on the Internet. Active X controls work with your
computer to perform tasks on the website you are using. Some websites, such as the Medicare DDE site,
require you to install ActiveX controls.

To install the Active X control:
1. On the Medicare DDE landing page, click the Launch Medicare DDE button.

2. The Rocket Software© website prompts you to install an add-on. Follow the prompts in the Information
Bar.

3. Internet Explorer may prompt you to send your information again. If it appears, click the Retry button in
the Explorer pop-up.

4. From the Security Warning pop-up, click the Run button. Several caching messages will display rapidly.

Internet Explorer - Security Warning x

Do you want to run this software?

III Mame: BlugZone Mainframe Display
Publisher: Rocket Software, Inc.

¥ | Mare options Run

| '-‘ll While files from the Internet can be useful, this file type can potentially harm
"%/ your computer. Only run software from publishers you trust. What's the risk?

The CMS Login screen appears on top of the Medicare DDE page (it may be minimized when it opens). You
have successfully installed the ActiveX control that lets you perform tasks in FISS and on the Medicare DDE
website.

p 51 - eSoluticns - Navigator 2.1 =T

File Edit Session Options Transfer View Script  Help

| Connections: |r§l Mavigator v1 v| @ | O] 0 E=R &

| PFO1 PFOZ PFO3 PFO4 PFOS PFO6 PRO7 PFOE PRO9 PFI0 PFI1  Clear Attention

Ready 10.0.1.32 TIMKO794 ki 00:00:06 24,037
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Log into a Medicare DDE session

To log into a Medicare DDE session:
1. Using Internet Explorer, log into the Waystar portal.
2. Goto MEDICARE > DDE > DDE Launcher.

If you see the following error message, then you are not set up as an active user. See the Setting up

permissions and active users section for more information.

MY WORK + CLAIMS PROCESSING PATIENT TOOLS ¥ ANALYTICS * MEDICARE ~ ACCOUNT ADMIN ~

Medicare DDE

DDE Launcher Reports Settings

DDE Launcher

Access Error h

You do not have permission to launch the Medicare FISS DDE tool. To gain access, your domain admin must give you permission in the User Management Settings area.

Mote: Adding additional users may result in additional charges.

With the correct permissions, you’ll see the following screen.
3. Click the Launch Medicare DDE button.

MY WORK ¥  CLAIMS PROCESSING ¥  PATIENT TOOLS + ANALYTICS + LU=0lle i gN ACCOUNT ADMIN +

Medicare DDE

DDE Launcher Reports  Settings

DDE Launcher

would.

If you need any assistance, please contact Client Services at 1.866.633.4726

Launch Medicare DDE h

Medicare DDE allows you to take advantage of Waystar's secure direct connection to Medicare. This connection allows you to process claims and check eligibility just as you normally

Eligibility ¥

© 2022 Waystar Health. All rights reserved.
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The CMS home page will appear.
4. From the File menu, select Open Session > Mainframe Display.
The following screen displays when you first connect.

5. Type in the number for the data center you use.

p 51 - eSclutions - Navigator 2,

File Edit Session Options Transfer View Script Help

| Connections: |é Navigator v1 v| @ | a 0 & &
| PFO1 PFROZ2 PRO3 PFO4 PROS PRO6 PRO7 PFOE PRD9 PFID PF11  Clear Attention

Ready 10.0.1.32 TIMKO734 i 00:00:06 24,037

The login screen will appear.
6. Enter your DDE/FISS Userid and Password.

i §1 - eSolutions - Mavigator 2.0

Fbe Edt Ssssion Options  Transfer Wiew Mscro Script Help

| Connections: | & Verizon Diect v @ |3 BEERh
|P‘F0] PFOZ FPFO3 PFO4 PROS PFOS  PFOT  PFOE  PFO9  FFI0 PFIL Clear  Attention

REL 5.2/00

(or LOGOFF) 16:17:33
Password: es/15/11
New Password: TivVZIezls
Account: 3192-2A
Transfer: SMRTTEST

Data contained is this system is confidential and proprietary. Use of t
for other than legitimate purposes authorized by CDS of 5C will be p

156.73.215.10 TIVZ0218 i 00:00:46

You are now connected to FISS with Medicare DDE. You can begin working with your Medicare claims.

© 2022 Waystar Health. All rights reserved. 12
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Setting up permissions and active users
IMPORTANT: For admin users only.
This section explains how an admin user or security manager can set up active users for Medicare DDE and
how they can set permissions for users.
Setting up Medicare DDE user permissions
Admin users and security managers can grant user permissions for other admin users or for base users.
To set up permissions:
1. Admin user or security manager goes to ACCOUNT > Security > Users.
From the list of users, find and select the appropriate user.
Click the Permissions tab.
Click the Advanced tab.

Scroll the list of permissions to find Medicare DDE (2).

o > on

Tip: To find the permissions more easily, press <Ctrl> <f> and search for Medicare DDE. The
following is an example of the Chrome Search Field:

medicare dde| 1/3 A v X

6. Click the appropriate permissions checkbox(es).

Account

Summary  Enrollment  Account Profile 550  Security Reports  User Preferences  Account Breakout  Notifications

| Users

Users
) . Search [_] Include Inactiv [_] Show Vendor Users Show All
Multi-Domain Users = o

Permission Sets © New User | General Accounts Permissions Landing Page Roles Reset Password 2FA
» (MMDemo)

Roles Permissions History
Settings Simple Advanced h
Two Factor Authentication O medicare Analytics - Biller Reports Report

[] Report

SFTP Management

» [ Check Al Medicare DDE (2)
(0 Medicare DDE - Access DDE Report
(0 Medicare DDE - Admin User Report

» [ check Al Medicare Claims Editor (4)
Ll obchia e oo Baoort

© 2022 Waystar Health. All rights reserved. waystar.com 13
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Medicare DDE — Admin User:

e This permission controls which users have access to the Medicare DDE Settings screen to
manage users who can access the Medicare DDE Launcher.

¢ Admin users and security managers are assigned this permission automatically.
Medicare DDE - Access DDE (base user):
e This permission allows users to access Medicare > DDE > DDE Launcher.

e Base users control the list of users that display in the “Available Users” list in the Medicare DDE
Settings screen.

o A user must have the Access DDE (base user) permission to appear in the Available Users list
and, as appropriate, launch Medicare DDE.

e Admin users and security managers are assigned this permission automatically.

Setting up active users for Medicare DDE

This section explains how an admin user or security manager can set up active users, giving the user the
ability to launch Medicare DDE.

IMPORTANT:

e Adding additional users could result in overage charges because your billing is based on your
organization’s contracted rate for active users.

e To be set up as an active user, that user must first have permissions set to Medicare DDE — Access
DDE. Without this permission, a user navigating to MEDICARE > DDE > DDE Launcher will see this

error message:

MY WORK + CLAIMS PROCESSING ~ PATIENT TOOLS ¥ ANALYTICS ~ MEDICARE ~ ACCOUNT ADMIN ~

Medicare DDE

DDE Launcher Reports  Settings

DDE Launcher

Access Error h

You do not have permission to launch the Medicare FISS DDE tool. To gain access, your domain admin must give you permission in the User Management Setlings area.

Mote: Adding additional users may result in additional charges.

© 2022 Waystar Health. All rights reserved. waystar.com 14
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To set up active users:
1. Admin user or security manager logs into the Waystar portal.
2. Goto MEDICARE > DDE > DDE Launcher > Settings tab.
3. From the Filter Users field, find the appropriate user.

If you can’t find the user, make sure they have their permissions set to Medicare DDE — Access DDE.

4. Select the user, and then click the right arrow button.

IMPORTANT: Adding additional users could result in overage charges because your billing is based
on your organization’s contracted rate for active users.

5. When finished adding active users, click the Save Settings button at the bottom of the screen.

MY WORK * CLAIMS PROCESSING ~ PATIENTTOOLS » ANALYTICS v [N LI3REN ACCOUNT ADMIN ~

Medicare DDE
DDE Launcher  Reports  Settings
Your billing is based on your contracted rate for active users. Adding additional users could result in overage charges.
Settings  History
Filter Users
Available Users 1277 Active Users 0
~ | & | There are no active users
Select users in the Availab
<« | fotheleftand click th
this team
abc123 abc123
-
@ You may hold "shift" to select many users in a row or "ctrl” to select many seperate users
Save Settings

© 2022 Waystar Health. All rights reserved. waystar.com 15
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Troubleshooting

Difficulty getting started — Trusted Zone

If you have difficulty getting started, be sure that you added our website to the Trusted Zone. Some facilities
have restrictions that require a domain administrator to install Active X controls. If you work with more than one
Fl, Client Services can help you customize your setup to allow for this.

FISS screen locked

If you inadvertently type in an area of the screen that is not recognized, the FISS screen locks. The locked
screen is identified by the X Not Here message in the lower left corner (see screenshot). To release the locked
screen, press <Crtl> <r> and tab to the next field.

PROCESS COMPLETED i NO MORE DATA THIS TYPE
PLEASE MAKE A SELECTION, ENTER NEW KEY DATA, OR PRESS PF3 TO EXIT

S1 | [XMNotHere @ AP Adtive - A T1vVZ0041 o 105718 11/20/2013 HUM 00:06:54 13.035
\

-

Cannot connect to the FISS system

There are a number of reasons why Medicare DDE may be prevented from fully functioning. The following
steps can be used to help eliminate causes. In some cases, you may need to involve your IT department or
domain administrator if you do not have administrative rights for your computer.

e Medicare DDE requires Internet Explore 64bit.
Note: Safari, Firefox, and Chrome are not supported.

e Make sure pop-up blockers are turned off for the Medicare DDE website. You may also need to
in your browser settings.

e Try to uninstall and reinstall Medicare DDE.

First time launching Medicare DDE
To start Medicare DDE:

1.

2. Click Launch Medicare DDE.

3. Allow BlueZone Software to run. This may require admin rights.

Password isn’t working on the FISS screen

The Medicare DDE service is a connection to the Medicare data center. Your DDE User ID, access
permissions, and password is maintained by your Medicare Administrative Contractor (MAC). If you cannot log
into the Medicare system, or cannot access certain areas, you will need to contact the EDI department for your
MAC.
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Revision Log

Description Version

April 2022 Updated the Log into a Medicare DDE session section 3
Added the Setting up permissions and active users section
Combined the Troubleshooting and FAQ sections under the Troubleshooting heading

Removed the Getting Support section as it pertained to legacy eSolutions
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